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Introduction  

Welcome!  
 

Thank you for making the Alesis ProLinear DSP a part of  
your studio. Since 1984, we've been designing and building 
creative tools for the audio community. We believe in our 
products, because we've heard the results that creative 
people like you have achieved with them. One of  Alesis' 
goals is to make high-quality studio equipment available to 
everyone, and this Reference Manual is an important part of  
that. After all, there's no point in making equipment with all 
kinds of  capabilities if  no one explains how to use them. 
So, we try to write our manuals as carefully as we build our 
products.  

For more effective 
service and product 
update notices, please 
register your 
ProLinear DSP online 
at: 
http://www.alesis.com/
support/warranty.htm 

 
The goal of  this manual is to get you the information you 
need as quickly as possible, with a minimum of  hassle. We 
hope we've achieved that. If  not, please drop us an email 
and give us your suggestions on how we could improve 
future editions of  this manual.  
 
We hope your investment will bring you many years of  
creative enjoyment and help you achieve your goals.  

 
Sincerely, 
The people of  Alesis 
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  Introduction 

About the ProLinear DSP 
 
The ProLinear DSP is a powered two-way speaker that offers 
the following features: 
 

• Increased bass frequency range with more accurate 
response 

 

• Increased Sound Pressure Level (SPL) capacity 
 

• Lower distortion 
 

• Smoother frequency response 
 

• Single Speaker Configuration – there’s no difference 
between left and right cabinets, so place them in 
either location 

 
DSP Control 
 

The ProLinear DSP’s Integrated DSP Module controls the 
equalization and output level of  the speaker. There are two 
ways to access this control: through the front panel buttons 
and LCD, or from your PC via the supplied software and the 
serial port on the rear panel of  the speaker.  
 
PC Integration 
 

Through a standard 9-pin PC serial port on the back of  the 
ProLinear DSP, you can connect your speaker to your 
Windows-based personal computer. Your PC and the Alesis 
ProLinear DSP software provide you unparalleled flexibility in 
creating, saving, and managing specific equalization programs 
and configurations, which you may then recall without ever 
having to touch the speaker. 
 
Key features of the ProLinear DSP 
 

• Bi-amplified near-field reference monitor providing 
approximately 120 watts 

 

• Integrated DSP Module with 24 bit processing for 
precise driver crossover and smooth response 

 

• 4-Band Parametric EQ with shelving and high pass 
filtering options 

 

• Ability to control individual speakers or groups of  
speakers via the 9-pin RS-232 port 

 

• Input level potentiometer with 1/4" TRS/XLR 
combination connector that supports levels from +4 
dBu to –10dBv 

 

• Internal universal 110v/220v power supply 
 

• 8 preset programs 
 

• 8 user-definable programs 
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 Introduction  
How to Use This Manual 
  
This manual is divided into the following sections describing 
the various functions and applications for the ProLinear DSP. 
While it's a good idea to read through the entire manual once 
carefully, those having general knowledge about studio 
equipment should use the Table of  Contents or the Index to 
look up specific functions. 

Helpful tips and advice are 
highlighted in a shaded box 
like this. 
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Chapter 1: Getting Started. Whether you are an experienced 
studio technician or a practicing musician, these simple 
diagrams and explanations can help you quickly get your 
ProLinear DSP connected to a line level output source (e.g., 
mixer) and/or your PC.  

When something important 
appears in the manual, an 
exclamation mark (like the 
one shown at left) will appear 
with some explanatory text.  
This symbol indicates that 
this information is vital when 
operating the ProLinear 
DSP. 

 
Chapter 2: Operations gives you detailed instructions for 
operating the ProLinear DSP from the front panel. 
 
Chapter 3: Using the Software provides a detailed, step-by-step 
how-to for operating the ProLinear DSP through the included 
PC software (note: this can only be accomplished if  the 
speaker is attached to a Windows-based computer through the 
9-pin serial port).  
 
Chapter 4: Frequently Asked Questions covers many of  the 
important and practical questions about how to set up and use 
the speakers.  
 
Chapter 5: Specifications lists important technical features and 
environmental requirements of  the ProLinear DSP.  
 
Chapter 6: Troubleshooting gives you some of  the more common 
problems and solutions. 
 
The Appendix contains descriptions of  the EQ curves used in 
the Preset and User Programs. 
 
At the end of  the manual we have included an Index, which 
will help you locate specific information. 



  Introduction 

 6 

 
This page intentionally left blank



 

Getting Started  1  

 
A Tour of the Rear Panel  
 
 
 
 
 Input Level 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Serial Input 
(from other 
speaker or 
computer) 

XLR/TRS 
Audio Input 

IEC Power 
Connector 

Serial Output 
(to another 
speaker) 

Power Switch 

 

T he rear panel of  the ProLinear DSP contains the following: 

• Input Level control—to adjust the strength of  the signal coming 
into the speaker. This allows all types of  audio sources to be 
used, from stand-alone CD players to professional mixers.  

• Power switch—turns the ProLinear DSP off  or on 
• Female XLR and 1/4" TRS balanced combination 

input connector 
When the speaker is 
powered on, there is a delay 
of about 4 seconds before 
the speaker begins operating 
while the unit performs its 
initialization and self-test 
procedures. 

• Two Data Link 9-pin RS-232 serial ports: 
o One female “in” port for connecting to a 

PC or another speaker 
o One male “out” port for connecting two 

or more ProLinear DSP speakers 
• IEC power connector to provide power from a 

100-230v, 50-60 Hz A/C power source 
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 1 Getting Started 

Connecting the ProLinear DSP 
 
The ProLinear DSP has two primary back-panel connector 
types: 
  

• A combination XLR and 1/4" TRS balanced input 
for connection to a mixer or any other line-level 
output source 

• Two 9-pin RS-232 jacks, one female and the other 
male, for connection to a PC and/or another 
speaker.  

 
 

PC

Serial Port

IN   OUT

Line
Input

ProLinear DSP

IN   OUT

Line
Input

ProLinear DSP

MIXER, ETC.

IN   OUT

Line
Input

ProLinear DSP

ProLinear DSP Connection Example

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The serial ports of the 
speakers may be connected 
in any order.  

 
 
Audio connections 
 

Connect each speaker to the appropriate output jack on a 
mixer or any other line-level output source. If  your mixer 
supports the 5.1 Surround format, you will connect five 
ProLinear DSP speakers—one speaker for each channel, 
connected from the appropriate “out” on your line-level 
output source to the line input on each speaker. 
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Connecting ProLinear DSP speakers   
 

You may connect up to sixteen ProLinear DSP speakers 
by the RS-232 inputs and outputs. Simply attach a 9-pin 
RS-232 male/female cable from the Data Link “out” 
port on one speaker to the Data Link “in” port on the 
other. Linking speakers in this way allows for increased 
control and flexibility, as you can set up matching curves 
very quickly. 

The speakers must be on the 
same Channel to allow them 
to be controlled as a group. 
See the section “Channel 
Mode” on page 17 for more 
information about changing 
speaker channels.  



 Getting Started 1 

Connecting the ProLinear DSP to a PC 
 

Attach the male end of  a standard 9-pin, PC serial cable to the 
Data Link “in” port on the back of  the ProLinear DSP. Attach 
the other end to one of  the serial ports on your computer.  
 
In order for the ProLinear DSP to communicate properly with 
your PC, the software on the included CD-ROM must be 
installed and then the set to the proper communication 
channel. Instructions on installing the software begin in the 
next section. Also, you may want to refer to the section 
“Changing the COM Port Number” on page 33. 

PC

Serial Port

IN   OUT

Line
Input

ProLinear DSP

IN   OUT

Line
Input

ProLinear DSP

IN   OUT

Line
Input

ProLinear DSP

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Serial Port Connection Diagram 
 
 
 
Installing the software 
 
The ProLinear DSP software is a standard Windows-based 
application that works with Windows 95, 98, ME, 2000, and 
XP. A CD is included that will install the software onto your 
computer. Chapter 3 explains how to use the software. 
 
System Requirements 
 

In order to run the software, your PC will need to meet the 
following minimum requirements: 
 

• 7MB of  hard disk space 
 

• 32MB of  RAM 
 

• 1 Com Port for serial interface 
 

• Windows 98/ME/NT/2000/XP 
 

 9 



 1 Getting Started 

Installation procedure 
  

• Insert the included CD-ROM. It should start itself, 
but it’s possible you may have to double-click on 
the setup.exe filename located on the CD-ROM. 
This will bring up the ProLinear DSP Install 
Wizard. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
• Click the Next button to continue. This will bring 

up the License Agreement window. Read the 
license agreement and click Yes to accept the 
terms. 
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 Getting Started 1 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

• After the licensing agreement, you need to enter 
the user information. It is possible to specify 
whether the software may be used by anyone who 
uses the computer, or just you. 

• When finished, click the Next button to continue. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• The next step in the installation process is to select a 

location for installation. Although the software suggests a 
default location, you can specify another location by 
clicking the Browse button. Once you are satisfied with 
the location, click the Next button to continue. This will 
bring up the Select a Program Folder window. 
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 1 Getting Started 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• The Select Program Folder window provides you the 
option of  specifying the Program Group in which the Alesis 
ProLinear DSP icons will be available. Again, the software 
suggests an appropriate group. If  you wish to use an existing 
group, simply browse the list and select it with your mouse. 
Otherwise, type in a new Program Group name. Once you 
are satisfied, click the Next button to continue.  

 
• After specifying the Program Group, the software will install 

application files into the appropriate folders on your hard 
drive. The Progress bar will indicate what has been 
accomplished and what remains to be installed. 

 
• Finally, upon completion, the Installation Wizard displays 

the InstallShield Wizard Complete window. This window 
informs you if  everything has gone well with installation. If  
so, click the Finish button to exit the Wizard. 
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The Front Panel  
  
The ProLinear DSP front panel contains a Liquid Crystal Display 
(LCD) and six buttons that serve different functions within each 
mode of  operation.   
 
 
 
 
 
 
 
 
 
 
 

Volume/Parameter Down Program/Value Down 

Program/Value Up

LCD 

BAND

kHzFREQ

Volume/Parameter Up 

Save/Band 

Page 

  The ProLinear DSP Front Panel 
 
The display shows different combinations of  text and 
numbers depending on the parameter being edited. The 
information displayed includes: 
 

• the Program number and Bank (User or Preset) of  
the current EQ curve 

• the boost/cut amount for the selected EQ band 
(Gain), and  

• the Channel to which the ProLinear DSP is 
assigned.  

 

Accompanying each value will be its unit of  measurement, 
when applicable (Hz, kHz, or dB). 
 
When the LCD flashes…  
 
Occasionally the LCD backlight will flash. This happens to alert you 
to one of  two conditions: 
 

• An edit affected another speaker on the same Channel. 
When two or more ProLinear DSP speakers are set to the 
same Channel, an edit performed on the first speaker will 
“propagate” to all the speakers that follow. When this 
happens, the backlights on the “slave” speaker LCDs will 
flash. 

• The signal is clipping. If  the Input Level control is set too 
high, the incoming signal can cause the speaker amplifier 
to clip. In this case, the LCD backlight will flash red. 

 
The buttons access and modify speaker parameters and functions. 
We will detail their operation within each Mode as it is discussed. 
 



 2 Operations 

Operational Overview 
 
The ProLinear DSP offers three methods of  control: 
 

• the front panel buttons and LCD  
• the PC software  
• the Input Level control on the rear panel  

 

Through these controls the following functions are managed: 
 

• Volume 
Frequency 

• Parametric EQ  Gain 
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Note: For proper gain 
staging, the lowest possible 
noise floor, and the most 
accurate representation of 
the signal, we recommend 
the volume be adjusted by 
the rear panel control. Use 
the Gain Trim feature only 
as a temporary measure. 

Q 
• Speaker ID/Channel assignment 
• Input Level monitoring 

 
Volume 
 

Volume is controlled in two ways: by the rear panel Input 
Level control and by the Gain Trim parameter accessed from 
the front panel (see the Program Mode description in this 
section).  
 
The Input Level control adjusts the signal level going into the 
Integrated DSP Module. Setting this too high could result in 
distortion, and setting it too low could result in unnecessary 
noise or loss of  resolution.  
 
The Gain Trim parameter adjusts the output gain from 
the Integrated DSP Module into the amplifiers, and can 
be adjusted within a range of  -18dB to +17dB. The 
same care must be taken when setting this level so as to 
avoid distortion and noise.  
 
Parametric EQ  
 

The ProLinear DSP has a four-band parametric equalizer 
that allows a great deal of  flexibility in “voicing” the speaker 
(setting its tonal balance). Each of  the four bands of  the 
equalizer consists of  three settings: frequency, gain and Q. 
 

• Frequencies can be set in 1/6th octave increments 
within a range of  20Hz-20kHz. 

 

• Gain adjustments may be made for each band within 
a range of  –12dB to +6dB. The changes from -10 dB 
to +6dB are made in 0.1dB increments, while the 
changes from –12dB to -10dB are measured in 1 dB 
increments. 

 

• Q values (the frequency range covered by a band) 
range from 0.25 to 4.00 octaves. It is possible to 
manually select Q values of  HSH (high shelving), 
LSH (low shelving) HP (high-pass filter). For 
definitions of  these settings, see page 27. 
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Speaker ID/Channel assignment  
 

This parameter allows you to assign the speaker to a particular 
Channel. If  all speakers are on separate Channels, a PC can 
control them independently. If  two or more speakers share a 
Channel, they constitute a “group” of  speakers and can be 
controlled simultaneously with a single command. 
 
Input Level monitoring 
 

This feature allows the user to monitor the input level to the 
Integrated DSP Module in real-time. It is extremely useful 
when calibrating two or more speakers so their input levels 
match. 
 
Description of Modes 
 
Power Up the ProLinear DSP  

Note: When the speaker is 
first turned on, it goes 
through an initialization 
process that lasts roughly 
four seconds. The display 
will remain blank until the 
initialization process is 
complete. 

 

At startup, the speaker shows the letters dSP in the display. 
After this, the version number of  the software is shown 
briefly. The speaker then goes into normal operation. 
 
From this point on the ProLinear DSP will operate within 
one of  the following modes: 
 

• Program mode allows you to select one of  the 
eight preset or eight user-defined programs. It has a 
sub-mode where the Gain Trim is set. 

• Channel mode gives you the ability to change the 
speaker’s current Channel, or Speaker ID number. 

• Edit mode is where all of  the equalization curves 
are created. 

• Save mode allows you to save the new EQ settings 
to a user-defined program. 

• Input Level mode enables you to monitor the level 
of  the input signal. 

 

A description of  each of  these modes is on the following 
pages. 
  
Program Mode 

 15 

Warning: After you make an 
edit to a Program, you must 
save those changes to one of 
the User Program locations. 
If you change programs 
before you do, the edits you 
have made will be lost. For 
information on how to save 
an edited Program, see the 
description of Save mode on 
page 20. 

 

When the ProLinear DSP is first powered up, it displays its 
“top-level” screen: Program mode. From here you may select 
one of  the eight preset or eight user-defined programs. It is 
also where you will find the Gain Trim parameter, which 
is discussed on the next page.  
 
When the speaker is in Program mode the word Program 
will be lit on the LCD screen, along with the Bank 
indicator (either Preset or User). The number in the display 
indicates which Program is currently selected.  
 
Program mode is the default mode for the ProLinear DSP. 
The unit will return to this mode from any mode after 30 
seconds of  inactivity, with the exception of  Input Level mode.  
 



 2 Operations 
Program Up

There are two buttons that are used in selecting a new 
Program: 
 

• Program Up advances to the next Program. It 
also changes the Program of  any other speaker on 
the same Channel. 

• Program Down selects the previous 
Program. It also changes the Program of  
any other speaker on the same Channel. 

Program Down

 This is known as the “double-
button reset” trick. Use it to 
reset nearly any parameter to 
its default value. 

Pressing the Program Up and Program Down buttons at 
the same time while in Program mode will take the unit 
back to Preset Program 1.  
 
The ProLinear DSP will remember which Program was last 
selected when the unit was turned off  and recall it when the 
unit is turned on again. 
 
Setting the Gain Trim  
 

Within Program Mode you can also change the Gain Trim 
setting. This parameter controls the level after the EQ 
settings as the signal heads into the speaker’s amplifiers. It 
will raise or lower the speaker’s volume, and will do the 
same for every speaker that is set to the same Channel 
(see Channel Mode on the next page).  

Remember: use the rear 
panel Input Level control 
instead of the Gain Trim to 
set the proper volume, as it 
will yield optimal signal to 
noise performance. Use the 
Gain Trim feature only as a 
temporary measure.    

From Program mode, the first press of  one of  the Volume 
Up/Down buttons calls up the Gain Trim parameter. The 
screen will look like this: 

Gain Trim Up 

Gain Trim Down 

 
 Gain Trim value  
 
 
 
 
 
 
 

Gain Trim edit indicator  
 
 
 
The Gain Trim adjustment range is from - 18dB to +17 dB. 
The changes from -10dB to +10dB are made in 0.1dB 
increments, while the changes from -18dB to -10dB and 
from +10dB to +17 dB are measured in 1dB increments. 
Holding one of  the Gain Trim buttons will cause the values 
to scroll quickly.  

Remember the “double-
button reset” trick: pressing 
the Value Up/Down buttons 
at the same time will reset 
the Gain Trim value to its 
default.  

Like the Program number, the Gain Trim setting is also 
remembered when the speaker is turned off. When it is 
turned on again, this parameter will be set to the selected value 
automatically.  
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Channel Mode Channel Mode 
 

What are Channels? 
 

What are Channels? 
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When two or more ProLinear DSP speakers are connected 
through their serial ports, it is possible to control them 
independently or as a group (or as several groups). This is 
achieved by assigning each speaker to one of  the sixteen 
available Channels. 

 

When two or more ProLinear DSP speakers are connected 
through their serial ports, it is possible to control them 
independently or as a group (or as several groups). This is 
achieved by assigning each speaker to one of  the sixteen 
available Channels. 
  Remember: there is a 

distinction between the term 
“Channel” when it refers to 
Channel mode in the 
ProLinear DSP, and the term  
“channel” as it applies to the 
audio being sent into the 
ProLinear DSP. It is likely 
that two speakers on the same 
Channel mode Channel will 
be processing different audio 
channels from the mixer or 
other audio source. 

A Channel is an Identification Number (ID) that uniquely 
identifies a speaker or a group of  speakers, so that sending 
commands to one Channel modifies only the speakers that 
are set to that Channel.  

A Channel is an Identification Number (ID) that uniquely 
identifies a speaker or a group of  speakers, so that sending 
commands to one Channel modifies only the speakers that 
are set to that Channel.  
  
For example, let’s say you have a setup of  four ProLinear 
DSP speakers. Due to the acoustic properties of  the room, 
the first two speakers need to have one EQ curve while the 
last two speakers need a completely different curve. One 
way to handle this is to assign the first two speakers to 
Channel 1 and the second two speakers to Channel 2. Using 
your PC and the included software, you will be able to 
modify the speaker pairs individually. 

For example, let’s say you have a setup of  four ProLinear 
DSP speakers. Due to the acoustic properties of  the room, 
the first two speakers need to have one EQ curve while the 
last two speakers need a completely different curve. One 
way to handle this is to assign the first two speakers to 
Channel 1 and the second two speakers to Channel 2. Using 
your PC and the included software, you will be able to 
modify the speaker pairs individually. 
  
For most two- to six-speaker setups, the user may want to set 
all channels to “1”, for example, to allow all the speakers to be 
controlled as a single system. 

For most two- to six-speaker setups, the user may want to set 
all channels to “1”, for example, to allow all the speakers to be 
controlled as a single system. Channel Up Press 

Together   
To modify the ProLinear DSP’s Channel setting: To modify the ProLinear DSP’s Channel setting: 
  

1. Press the Save and Page buttons simultaneously 
to enter Channel mode. 

1. Press the Save and Page buttons simultaneously 
to enter Channel mode. 

2. Use the Up/Down buttons in the “Program” 
column to adjust the Channel number. 

2. Use the Up/Down buttons in the “Program” 
column to adjust the Channel number. 

3. Press the Page button three times to exit Channel 
mode and return the speaker to Program mode. 

3. Press the Page button three times to exit Channel 
mode and return the speaker to Program mode. 

Channel Down   
Here is an example of  how the Channel Select screen 
might appear: 
Here is an example of  how the Channel Select screen 
might appear: 
  
  Remember the “double-

button reset” trick: pressing 
the Channel Up/Down 
buttons at the same time will 
reset the Channel value to its 
default (Channel 1). 

  
  
  



 2 Operations 

Edit Mode 
 

Edit mode is at the core of  the ProLinear DSP’s features. 
This is what allows you to adjust the EQ curve parameters 
such as Frequency, Gain, and Q. After you have created the 
EQ curve you want, these settings can then be saved to one 
of  the eight User Program locations.  

The edited Program will be 
retained when the speaker is 
powered down, even if it has 
not been stored to a User 
Program location. When the 
speaker is powered up, these 
custom settings will be 
restored. However, if you 
select another Program, the 
edited Program will be lost. 

 
How it works 
 

When you select a Program, a copy of  that Program is 
made into a temporary location called the “Edit buffer.” 
This is where the edits actually take place. If  you do not 
save the edits you have made before selecting another 
Program, the original Program will not be affected. Therefore, 
you should be sure to save any edits you want to keep before 
selecting another Program! See page 20 for a description of  
how to use Save mode. Next Parameter 

(Up Button)  

Value Up 

To edit the EQ parameters, use the Band, Parameter and Value 
buttons. Their labels are in blue text next to the buttons. 
Here’s the procedure: 

Change Band Value Down 

Enter Edit  

1. Press the Page button to enter Edit mode. 
2. Use the Parameter Up/Down buttons to move 

between the three parameters for the selected 
band. 

3. Use the Value Up/Down buttons to change the 
value of  the selected parameter. Press them both 
at once to reset the value to its default. 

4. Press the Band button to select the next EQ band 
you would like to edit, and repeat steps 2 and 3. 

5. Press the Page button to return to Program mode. 
 

Previous Parameter 
(Down Button) 

 
Below is an example of  what the display might look like in 
Edit mode: 
 

Frequency Value  
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 Indicates the 

Band being 
edited 

After 30 seconds of 
inactivity, the ProLinear 
DSP will automatically exit 
to Program Mode. 

 
 

”FREQ,” “Q,” or “GAIN” will be lit 
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Editing an EQ Curve 
After you make an edit to a 
Program, you must save 
those changes to one of the 
User Program locations. If 
you select another Program 
before you do, your edited 
Program will be lost. For 
information on how to save 
an edited Program, see the 
description of Save mode on 
page 20. 

 

Once you are in Edit mode, there are three EQ parameters 
available. Use the Parameter Up/Down buttons to select the 
one you want to edit, and then use the Value Up/Down 
buttons to make an adjustment: 
 

• Frequency—select a value between 20Hz and 
20Khz.  

 

• Gain—select a value between -12dB and +6.0dB. 
 

 Gain Value 
 
 

TIP:  To disable an EQ band, 
set its GAIN value to 0 and its 
Q to anything but HP.  

 
 
 
 
 

• Q—select a value between 0.25 and 4.0 octaves. If  
the Value Down button is held, the values will 
“race” downward to 0.25 and stop. However, there 
are three more values which are accessed by 
additional presses of  the Value Down button: HSH 
(high shelving), LSH (low shelving) HP (high-pass 
filter). For definitions of  these settings, see page 
27.  

Note: if a Q value of HP is 
selected, the Gain parameter 
is not available.  

Remember the “double-
button reset” trick: pressing 
the Value Up/Down buttons 
at the same time will reset the 
selected value to its default. 
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Q Value
 
 
 
 
 
 
 
The Band button 

The Band button 

 

Press the Band button to select which of  the four Bands will 
be edited. Each has its own Frequency, Gain, and Q 
parameter. 
 
 
To exit Edit mode, hit the Page button twice. Keep in mind 
that any changes that were made will be lost if  another 
Program is selected before the edited Program has been saved. 
 



 2 Operations 

Program UpSave Mode Exit Save Mode 
 

Save mode allows you to preserve the changes you have made 
to the EQ curve by saving it to one of  the eight User Program 
locations.  
 
To enter Save mode, press the Save button. The Program 
number will begin to flash. From this point: 
 

• The Value Up/Down buttons select the User 
Program location into which the edited Program 
will be saved. 

• Pressing the Page button will exit Save mode 
without saving the Program and take the 
speaker to Program mode. 

Program Down 
Save Settings 

• Pressing the Save button again will save the 
edited Program to the selected User program 
location, and then returns
Program mode. Any spea
Channel will also save the
User bank. As the Progra
SAVED icon on the disp
about two seconds. 

If you attempt to store a 
Program to a Preset 
Program location, the 
ProLinear DSP will 
automatically store the 
Program to the same 
number location in the User 
bank.
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 Operations 2 

Input Level Mode 
 

The ProLinear DSP has an extremely useful feature called 
Input Level mode that can help you optimize the speaker’s 
performance. This mode allows you to measure the level of  
the incoming signal, which in turn makes it possible to adjust 
the rear panel Input Level control to its ideal position.  
 
In addition to allowing you to achieve maximum signal 
integrity for an individual speaker, Input Level mode can also 
be used: 

1. To be certain that all ProLinear DSP speakers in the 
system are at the same level, and 

2. To be certain all speakers are operating at an optimal 
signal-to-noise ratio (SNR). 

 
To optimize your setup, you need to send a constant, steady 
signal to the ProLinear DSP speaker. Most audio engineers 
would send the unit pink noise, white noise or a sine wave. We 
recommend that you purchase a reference CD containing 
these and other signals commonly used for level calibration. 
It’s very difficult to calibrate any professional audio device 
using regular music or program material.  
 
To use Input Level mode: Hold for three 

seconds  
• Starting from within Program mode, press and hold 

the Page button for three seconds. The following 
display is an example of  what may be shown: 

 
 
 
 
 
 
 
 

• Once this display is showing, reach around to the 
back of  the ProLinear DSP and set the Input 
Level control to its minimum position.  

 
• Select a test tone that has a level very close to 0dB 

on the CD player and send it to the speaker.  
 

• Slowly increase the Input Level control until the 
display reads -10dB.  

 
To exit Input Level mode, hit the Page button again. 
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 3 Using the Software    

 
The ProLinear DSP Windows application lets you easily 
control and configure your ProLinear DSP speakers through a 
standard 9-pin RS-232 serial connection. You can then apply 
these settings to one of  eight available user-defined programs. 
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Overview 
 
There are two main levels of  control in the PC software: the 
Channel level and the Program level. At the Channel level 
you may select which Channel the software is displaying, 
what Program is on each Channel, and what the Gain Trim 
setting is for each Channel. Once you have a configuration 
of  EQ curves and Channels you would like to keep, you may 
save them as a “Workspace” for later recall. 

Remember, a Channel may 
consist of one speaker or a 
group of speakers with the 
same Channel setting. 

 
At the Program level, you may adjust the equalizer 
parameters (Frequency, Q, and Gain) and then save the 
curve to one of  the eight User Program locations within the 
speaker and within the Workspace at the same time. You can 
also store a name with each EQ curve as well as a set of  
notes with the User bank you have assembled.  

The Curve Name is only 
viewable in the PC software. 

 
Here is an example of  the main software screen: 
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Navigating the Software 
 

The features of the software are accessed in three ways: 
 

• The pull-down menu at the top of  the main window, 
which gives access to the housekeeping features 
common to most Windows applications, such as file 
saving and opening, plus cut/copy/paste of  EQ 
settings, and pull-down access to most of  the 
features found elsewhere in the main window. Also 
found here are configuration options and an 
extensive Help file. 

 
• The Channel Bar, which has the labels “Control, 

Channel, Program, and Level” across its top. This is 
where you decide which Channel you will be working 
on, select its Program, and adjust its Gain Trim. 

 
• The Program Edit Window, which is itself  divided 

into two parts: 
 

o The EQ Tab, which is where edits are made 
to the selected Program’s EQ curve. Also 
accessible are an EQ Bypass button and a 
Save To User Location selector switch. 

 
o The Program Names/Notes Tab, which 

allows you to name each User Program and 
write notes regarding the entire Bank of  
User Programs, if  you desire. 

 
We’ll start with the fun part first, and save the “housekeeping” 
for later. 
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The Program Edit window 
 
The EQ tab is divided into four areas: 
 

• The Curve space, the green area showing a graphic 
representation of  the combined effects of  the EQ 
settings for each Band. Each of  the colored dots 
corresponds to one of  the Bands, and is used to edit 
the Frequency and Gain of  its Band. 

 
• The Controls, with four columns of  knobs and 

sliders, one for each Band, which can be used in the 
same way the hardware of  a physical equalizer would. 

 
• The EQ Bypass button, which allows you to hear the 

audio material without the Program’s EQ curve 
being applied. 

 
• The Save To User button, which enables you to save 

the curve you have created to one of  the eight User 
Program locations. In the lower right corner is a 
switch that allows you to select which of  the eight 
locations will be the destination for the curve when it 
is saved. 
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Editing the Program Curve 
 

There are two ways to change the equalizer settings. The first 
way is to click on one of  the colored dots in the Curve space 
and drag it to the point on the graph that corresponds to the 
desired Frequency and Gain settings for that Band. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As you move the colored dot, the graphic controls for the 
corresponding Band will move also, and display the numerical 
values for that Band’s settings. The only value that will not 
change with this method is the Q. To change that parameter, 
click on its knob and drag it through its positions. 
 
The second way to change equalizer settings is through the 
Controls at the bottom of  the EQ tab window. 
 
Each column has a colored “Band” label that corresponds to 
the colored dot in the Curve space. The Band’s Gain is 
controlled by the vertical slider, while its Frequency is 
represented by the upper knob and its Q is represented by the 
lower knob. To adjust any of  these settings, click on the 
proper graphic and drag it through the available values. 
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A note about HSH, LSH, and HP 
 
There are three additional settings for the Q parameter that 
are found below the value of  0.25: HSH, LSH, and HP. Here’s 
what they do: 
 

The LSH (Low Shelf) setting affects everything 
below the specified frequency, similar to 
conventional tone controls on a home stereo. For 
example, if  Band 1 is set for Low Shelf  and the 
frequency is set to 800Hz, everything from 800Hz on 
down will be boosted or cut. The following diagram 
shows high or low shelving: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
HSH (High Shelf) works the opposite way. When 
this function is turned on, everything ABOVE the 
set frequency will be affected. 
 
The HP (High Pass) setting turns the Band into a 
highpass filter. This button disables the Gain 
parameter for the Band. When this setting is in 
effect, all audio below the Band frequency setting will 
be filtered out at a slope of  6dB per octave. Its basic 
function is as a bass frequency rolloff.  
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Saving Equalizer Settings 
 

After you have adjusted the equalizer to your satisfaction, you 
can save the settings in one of  three ways: 
 

• The first way is to save the settings to one of  the 
User Program locations. 

 o At the bottom right side of  the Edit Tab 
window is a large green number. To its right 
is a “rocker” switch. Click on the top or 
bottom of  the switch to select a number 
from one to eight.  

 o Click the Save to User button to save the 
Program to that location. 

 

• The second way is to select the Save User Settings 
option from the Edit menu. This will automatically 
save your equalizer settings to the currently selected 
User Program. You can also accomplish this by 
pressing CTRL + U. 

 

• The third way is to select the Save EQ or Save 
Current EQ options from the File menu. These will 
bring up the Save As Window. 

 o Browse your hard drive for the desired 
folder. 

 o Type a name into the File name box. 
 o Click the Save button. 

 
Loading Equalizer Settings 
 

To open an existing equalizer file: 
 

• Select the Open EQ option from the File menu. 
This will bring up the Open window. 

 o Browse your hard drive for the location of  
the desired Program file 

 o Select it by clicking on it in the window. 
This will put the file name into the File 
Name box. 

 o Click the Open button. 
 
To reset the Equalizer to the default settings, select the New 
EQ option from the File menu. 
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Equalizer Workspaces 
 

In addition to saving your equalizer settings in a separate file, 
you can also save the settings of  all Channels and Programs as 
a Workspace.  
 
To save your Workspace: 
 

• Select the Save Workspace option from the File 
menu. This will bring up the Save As window. 

 o Browse your hard drive for the location to 
which you want to save the settings. 

 o Type a name into the File name box. 
 o Click the Save button. 

 
There are two ways to open an existing Workspace: 
 

• First and fastest, you can select the name of  your 
Workspace from the Recent Workspaces option of  
the File menu. The Workspace will automatically 
open. 

 

• Another method is to select the Open Workspace 
option from the File menu. This will bring up the 
Open Window. 

 o Browse your hard drive for the location of  
the Workspace file. 

 o Select it by clicking on it in the window. 
This will put the file name into the File 
Name box. 

 o Click the Open button. 
 
To reset the Workspace to the default settings, select the New 
Workspace option from the File menu. 
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Working with Channels 
 
A Channel is comprised of  either a single speaker set to a 
particular Channel number or a group of  speakers that are all 
set to the same Channel number. For a more detailed 
explanation of  Channels, see the Channel Mode section of  
Chapter 2 “Operations” on page 17.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Selecting a Channel 
 

There are two ways to select a channel: 
 

• The first way is to select a Channel from the 
dedicated pull-down menu on the main screen. 

 

• The second way is to look in the Control column for 
the number next to the Channel you want to select 
and click on it. This will turn the button green, 
indicating that the Channel has been selected. 

 
Channel Settings 
 

Once you have selected a Channel, you can modify its settings 
in a couple of  ways: 
 

• Select a Program by using the drop-down menu 
immediately to the right of  the Program name 

 

• Change its Level by using the Up and Down arrows 
to set the Gain Trim for the Channel. 
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Global Controls 
 

• The Dim button will set the Gain Trims of  all 
speakers on all Channels to -18dB. You can also 
accomplish this by selecting the Dim -18dB option 
from the Edit Menu or pressing CTRL + D. 

 Warning! Pressing the Save 
All Programs button will 
overwrite all eight User 
Programs in every speaker. 
Be sure this is what you want 
to do before you press it. 

• The Save All Programs button will take all eight 
User Programs from the PC application and save 
them to every speaker on every Channel. You 
can also accomplish this by selecting the Save A
Programs option from the Edit Menu. 

ll 

 
 
Program Names/Notes 
 
You can specify a name for each of  the User Programs in 
the PC software. There’s also a space where you can write 
notes that apply to the eight User Programs. To do this: 

Remember: the name you 
give the Program will not 
show up on the speaker LCD 
Panel.  

• Click on the Program Names/Notes tab.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 o Click in the text box to the right of  one of  

the eight User Programs and type in a name 
for that Program.  

 o Click in the Additional Notes box and 
you can record additional notes about 
your Programs. 

The Additional Notes space is 
shared between the eight 
User Programs. 
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Changing Settings 
 

There are a number of  settings that allow you to configure the 
PC software to your preferences. To change the application’s 
settings, select Options from the View menu. You will see this 
window: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Options window is composed of  three primary tabs: 
Colors, Settings, and Ports. 
 
Changing the Colors 
 

The four buttons show the colors that are used in the Curve 
space to help you distinguish visually between the four EQ 
Bands. To change the color for a Band, click on the button 
with that Band’s name. A color chart window will be 
displayed. Select the desired color and confirm your choice by 
clicking the OK button. You will see the colored dot for that 
Band change to the color you just selected. 
 
The Settings tab 
 

There is one option under the Settings tab. The Activate 
Receiving Channel option allows you to configure how the 
ProLinear DSP application will respond when a button is 
pressed on any ProLinear DSP speaker in the system. 
 
When the Activate Receiving Channel box is checked, any 
changes made from the front panel of  any speaker in the 
system will cause the PC software to select that Channel 
automatically and update the Curve space to that Channel’s 
new EQ curve.  
 
When the Activate Receiving Channel box is not checked, the 
PC software will not display changes made on any speaker 
unless they are made on the Channel that is currently selected. 
Changes made on other channels will be received, but the 
software will not change the EQ graph nor the active channel 
indicator. 
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Changing the COM Port Number 
 

We’ve provided a shortcut that allows you to change the 
communication port number for your ProLinear DSP 
speakers without having to access the Device Manager inside 
the Windows Control Panel. 
 
To do this, click on the Ports tab. You will see a screen that 
looks like this: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Use the drop-down menu to select the serial port through 
which your ProLinear DSP speakers will communicate with 
the PC. For more information about configuring serial com 
ports on your PC, see your operating system or hardware 
documentation. 
 
IMPORTANT: If  the com port that you configured in the 
Windows Control Panel is not listed here, then it is not 
available to the ProLinear DSP application. Choose the port 
you wish to use and exit the application without saving the 
configuration. Next, set up the appropriate port through the 
Windows Control Panel according to the appropriate 
procedure for your PC’s operating system. 
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 4 Frequently Asked Questions 

It is impossible to design a speaker that fulfills the 
requirements for every situation, but hopefully the ProLinear 
DSP will give you a versatility approaching that.  The 
following information will hopefully help you decide what is 
the best way to set up the speaker. 
 
Basic FAQs 
 
1. Can I play the speakers through the serial port of  my 
PC? 
 

No. The serial port is only for EQ and level control. 
 
2. Does the ProLinear DSP accept digital inputs? 
 

No, it only accepts analog audio signals. 
 
3. Can the ProLinear DSPs be placed on their sides? 
 

Yes. It does change the speaker sound field to some extent as 
you move in a horizontal direction, as would occur with any 
speaker, so slight adjustments to placement and EQ might be 
required. But the sonic characteristics of  the speaker remain 
pretty much the same.  
 
4. Can I place the ProLinear DSP against a wall, or in a 
wall? 
 

Yes. But the rear heatsink should be given adequate 
ventilation. If  the amp overheats the speaker will temporarily 
shut down to protect itself. It will be explained in another 
FAQ that when the speaker is placed in a wall, the frequency 
response will change, so this must be taken into consideration. 
 
5. Do I have to connect the serial RS-232 cables to get the 
speaker to work?  
 

No, the speakers will work just fine without these connections. 
What they would do is give you the added capability of  
controlling multiple speakers from the front panel of  one 
ProLinear DSP. They also allow you to control the speakers 
with a PC using the supplied software.  
 
6. Can I use this speaker in a 5.1 monitoring setup even 
though I don’t have a sub-woofer? 
 

Absolutely. The ability to chain the speakers to a PC gives an 
added dimension of  control not available with most surround 
speakers. The only issue at present is bass control. While the 
ProLinear DSP has an extended bass frequency response, 
there may be some applications for which a sub-woofer may 
be desired.  
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7. Do the speakers require a break-in period? 
 

Nearly all new speakers require a few hours of  bass-heavy 
material at a fairly loud volume to break them in. What this 
does is loosen up the driver suspensions and smooth out the 
response. The speakers were designed and calibrated to 
include the effects of  break-in and will sound even smoother 
afterward.  
 
8. When I turn my speaker on, I get no sound for about 4 
seconds.  My old monitors work right away.  What gives? 
 

There are two "computers" in the ProLinear DSP that take 
time to initialize before the speaker starts operating.  Most 
conventional active speakers have no digital signal processing, 
and as a result, don't have to go through this process.  Think 
of  it as similar to turning on a PC or Mac; there’s a “boot-up” 
period. 
 
9. When I change programs, I hear clicks and pops 
occasionally.  Is my speaker broken? 
 

It is not unusual to hear slight noises when changing 
programs. This is due to the discontinuous nature of  digital 
audio, and is most likely to occur when the programs are very 
different. 
 
10. When I change programs with the ProLinear DSP’s 
PC application I get loud pops.  What's happening? 
 

Another application you are using may have configured the 
serial port of  the PC improperly. In particular, the Flow 
Control must be set to "None." Exit any other application that 
may be misappropriating the serial port. Refer to the technical 
documentation regarding configuring the serial port within 
your PC’s operating system. 
 
11. The LCD display occasionally flashes red.  What does 
that mean?  
 

On start-up, it's the internal processor performing its 
initialization routine. This is normal. If  it happens during 
routine operation, it means the amplifier is clipping. The input 
source volume or the Input Gain control should be reduced. 
 
12. Can I do a “bulk dump” of  the User Programs from 
the ProLinear DSP into the PC application? 
 

No, but there’s a workaround. After connecting the PC and 
the ProLinear DSP system via the serial cable(s), call up the 
User Programs from the ProLinear DSP speaker in question 
one at a time, making sure they show up in the EQ Curve 
space (the green window inside the EQ tab). Then save them 
one at a time to the PC using the Save To User button and 
location switch. Then save the Workspace, which contains all 
the User Program settings, so you can recall the entire bank in 
the future. 
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Voicing and EQ FAQs 
 
1. How is the ProLinear DSP’s frequency response set at 
the factory? 
 

The response is set to be as flat as possible, typically +/- 
1.5db from 50Hz to 20kHz with advanced bass compensation. 
They are calibrated for “open space” placement (not against a 
wall). However, the ProLinear DSP can be tailored to 
compensate for many placement and mounting scenarios.  
 
2. If  this speaker is so flat, why do smaller, older 
speakers have more bass? 
 

The most likely reason is that the older speaker was EQ’d with 
too much bass to compensate for its small size. By the way, 
this is not true low bass, but is actually more in the mid-bass 
range. Some users find this mid-bass boost appealing, but 
those who are looking for accuracy probably won’t. There is a 
penalty to pay for doing this, too, in addition to the bloated 
sound: the loss of  dynamic range. This occurs because it takes 
a less powerful signal to reach the limits of  the speaker; it will 
start to distort or compress noticeably sooner than a larger 
speaker like the ProLinear DSP.  
 
3. Is it OK to set all the speakers to the same EQ via the 
serial port connections? 
 

That depends on how critical the listening application is for 
the speakers. A speaker’s placement has a big effect on its 
frequency response. Some applications may not be critical, but 
others might dictate a flat response, such as using the speaker 
for reference purposes. Keep in mind that the settings for one 
listening position may not be adequate for another. In such 
cases, it is possible to tune the ProLinear DSP speakers 
individually by assigning each speaker to a separate channel. 
With the user-defined EQ settings, you can have patterns for 
various listening positions. 
 
4. I need a speaker that plays loud. Monitor “X” has 
twice the watts than the ProLinear DSPs; therefore, they 
will play twice as loud, right?  
 

The simple answer is no! Power is only one factor as to how 
loud a speaker will play. You have to take into account driver 
efficiency, compression and distortion as well as cabinet 
design.  Keep in mind that when you double the power into 
the speaker, the most you can get is a 3dB increase in volume 
(and most of  the time it’s less, due to the factors mentioned 
above).  
 
The drivers we’ve chosen were selected for their low 
distortion, extended response and clean output at maximum 
level. The design was optimized for a near field monitor and 
as such, can play loud enough to damage your hearing if  
turned up too high. We have also tested them far-field in 
medium size rooms and they will play cleanly at reasonably 
loud levels.  
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5. Should I use the midrange attenuation Program for my 
own mixes? 
 

This depends entirely on your taste and the venue and 
objective for the recording. However, for the best recording 
possible, the midrange should be kept flat. This will give the 
truest indication of  the response and of  any EQ previously 
done to the recording.  
 
6. With the parametric EQ, can I model any brand of  
studio reference monitors? 
 

You can get a reasonable approximation of  the frequency 
response, but there is more to replicating a speaker than its 
frequency response. For example, certain drivers (e.g. woofers) 
may have good transient response. Others may not. Both 
could yield the same steady state (continuous tone) response 
but sound completely different to something with a fast 
transient response such as a snare drum or clapping.  By 
popular demand, one of  the Presets is modeled after the 
ubiquitous black monitor with white cones, but it is a rough 
approximation. There are two other speaker responses that are 
emulated, as well. See if  you can figure out their identities! 
 
7. How does the level control on the rear panel differ 
from the front panel Gain Trim control? 
 

The level control on the back attenuates the input signal to the 
speaker.  The Gain Trim control attenuates or boosts the 
output of  the DSP.  For large source signals you want to 
attenuate the input level so as to avoid saturating (clipping) the 
input Analog to Digital converter (ADC). The Gain Trim 
control should be adjusted to avoid saturating the output 
Digital to Analog converter (DAC). This must be done by 
listening for output distortion. The user should also be careful 
to avoid setting the attenuation levels too low, as this could 
lead to a loss of  resolution as well as a higher noise floor.  
 
To assist you with these adjustments, the ProLinear DSP 
provides the ability to monitor the input level to the ADC on 
the front panel display. For instructions on how to do this, see 
page 21. 
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Inputs 
 

Nominal input level:  +4dBu (-15dBFS) 
Maximum input level:  +20dBu (7.0 Vrms) 
Input impedance:   10kΩ 
 
Output  
 

Sound Pressure Level (SPL):  ~110db at 1 meter at 
max input below clipping 

Low Frequency (LF) power:  80 watts RMS,  
~130 watts peak 

High Frequency (HF) power:  40 watts RMS typical, 
~130 watts peak 

Frequency response:   50hz – 20kHz +/- 1.5dB    
Bass level -3dB @ 43hz 
typical 

Signal To Noise ratio:  > 90 dB A-weighted, 
Analog In to Analog Out 

 
Power Requirements 
 

Input voltage: 100v – 230v  
Input frequency:    47 – 63 Hz 
Power consumption:  20 W (idle) 

130 W (typical, at 
maximum volume)
  

Environmental Requirements 
 

Temperature range:   0-40 degrees C 
Relative humidity (non-condensing):  30-85% 
 
Cabling Requirements 
 

Mixer to Speaker: Balanced or unbalanced, 
shielded; XLR or ¼” 
TRS connector. 

 
Speaker to PC:   Standard 9-pin, RS-232 

serial cable (male-
female). 

 
Speaker to Speaker:  Standard 9-pin, RS-232 

serial cable (male-
female). 

 
Mechanical 
 

Size:    15” H x 9” W x 12” D 
Weight:    25 lbs (11.4kg)
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Symptoms  Cause  Solution 

No audio or output too 
low. 

 No input audio.  Test with a known good 
input. Increase input level 
pot setting. 

  Bad cables.  Replace the cables. 

  Source is turned down.  Increase source level. 

Distorted sound.  Input level too high and is 
saturating the input ADC. 
Note: the red LCD display 
may not be indicating 
clipping for this 
circumstance. 

 Turn input level control 
down. 

  Low frequency gain too 
high. 

 Reduce all LF parametric 
gain, lower the input level 
pot, reduce trim gain or 
lower the input signal. 

  Clipping (as indicated by 
the red LCD display) 

 Lower the input level 
control, reduce Gain Trim 
or lower the input signal. 

 “Err” on LCD display.  Speaker malfunction  Cycle power. 
  
Call Technical Support. 

  Attempting to do things 
too quickly on the front 
panel or PC application. 

 Wait for speaker to re-sync 
or cycle the power. 

  Turning off  one speaker in  
a group of  speakers 

Wait for speaker to re-sync 
or change the program on 
the affected speaker and 
then go back to the 
original program. 

PC will not communicate 
with speaker 

 Application set to different  
Com port 

Change port under 
View/Options tab in 
application 

  Speaker set to different 
channel 

 Make sure speaker and 
application channels agree 
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  Appendix  

 

Preset and User Programs 
 
PRESET   Name   USER   Name  
     1   Flat       1     Warmth 
     2   Hi-Fi (Smile)   2     Bass Boost 
     3   White Cone   3     Bass Cut 

4 Faux Finnish     4     Treble Boost 
5 Studio Cube    5     Treble Cut 
6 Boom Box    6     AM Radio 
7 BBC Dip    7     Narrow 
8 80 Hz High Pass     8     Portable Radio 

 
The Programs in the User bank are also available on the supplied CD-ROM. 
Feel free to overwrite any or all of them; if you ever want them back, use the 
“Open Workspace” option in the File menu and navigate to the file “user1.pws” 
on the CD-ROM. 
 
Descriptions of Each Program 
 
Preset 1 Flat   Flat frequency response (no EQ).          
 

Preset 2 Hi-Fi (Smile) A pleasant Hi-Fi listening curve in the 
Fletcher Munson vein  

 

Preset 3 White Cone  An emulation of the ubiquitous black monitor  
 

Preset 4 Faux Finnish  Modeled after an expensive near-field reference 
monitor  

 

Preset 5 Studio Cube  An imitation of the “worst case mix check” 
brown monitors  

 

Preset 6 Boom Box  Sounds like a big resonating boom box from 
the ‘80s. 

 

Preset 7 BBC Dip  A slight depression in 1kHz to 3kHz range, 
creating a more distant and relaxed sound. 

 

Preset 8 80 Hz High Pass  Removes rumble. 
 
 
User 1 Warmth  Cuts some highs, boosts some lows, generally 

warms up the sound. 
 

User 2 Bass Boost  Works as advertised. 
 

User 3 Bass Cut   Works as advertised. 
 

User 4 Treble Boost  Works as advertised. 
 

User 5 Treble Cut  Works as advertised. 
 

User 6 AM Radio  Recreates the frequency response of  AM 
radio. 

 

User 7 Narrow  It takes true genius to make speakers this 
good sound this bad. 

 

User 8 Portable Radio  An imitation of  the extremely narrow 
frequency response of  a tiny speaker. 
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